
Zip Manager 3.0 
Quick Help Index

This help file is designed as a quick reference to the material covered in the documentation. If you have a 
question not covered here please check the readme.1st file, and the documentation. If you are new to 
Windows you can press F1 to get help on Windows Help.

File & Edit Menu Help
Extract Menu Help
Comment Menu Help
View Menu Help
Option Menu Help
Switches Menu Help
Accelerator Key Reference
Technical Support
Registration Information 



Zip Manager
File and Edit Menu Help

-> NOTE: You can perform any of the tasks listed here and in the documentation on Self Extracting (EXE)
files created with ZIP2EXE. They are treated in exactly the same manner as Zip Files.

This will provide you with detailed help for each of these menu commands. If you still are unclear about a 
concept covered here, please refer to the program documentation and the readme.1st file.

Creating A New Zip File
Adding Files To A Zip
Moving Files Into A Zip
Deleting Files
Freshen A Zip
Update A Zip
Files Not Backed Up
Test A Zip



Zip Manager 3.0
Extract Menu Help

-> NOTE: You can perform any of the tasks listed here and in the documentation on Self Extracting (EXE)
files created with ZIP2EXE. They are treated in exactly the same manner as Zip Files.
Choose the menu selection you have a question about from the list below.

Extracting    Zip Files
Extracting    Arc Files
Extracting    Lzh Files



Zip Manager 3.0
Comments Menu Help

-> NOTE: You can perform any of the tasks listed here and in the documentation on Self Extracting (EXE)
files created with ZIP2EXE. They are treated in exactly the same manner as Zip Files.
Choose the menu selection you have a question about from the list below.

Add A Title Comment
Add/Edit Comments
Comment New Files Only
User Selected Files To Comment



Zip Manager 3.0
View Menu Help

-> NOTE: You can perform any of the tasks listed here and in the documentation on Self Extracting (EXE)
files created with ZIP2EXE. They are treated in exactly the same manner as Zip Files.
Choose the menu selection you have a question about from the list below.

Viewing a Zip
Clearing A View



Zip Manager 3.0
Switches Menu Help

Choose the menu selection you have a question about from the list below.

Password Encrypt
Store Path Info In Zip
Recurse Directories
Retain Original Date
Restore Directories On Extract



Zip Manager 3.0
Options Menu Help

Choose the menu selection you have a question about from the list below.

Using Your Text Editor
Using LIST.COM
Check For A Virus Using SCAN
Create A Self Extracting EXE
Repair a Damaged Zip



Zip Manager 3.0
Accelerator Key Reference

Choose the menu selection you have a question about from the list below.

Control Key Reference
Shift Key Reference



Zip Manager 3.0
Trouble Shooting Help

Choose the menu selection you have a question about from the list below.

Trouble Shooting
Technical Support



Zip Manager 3.0
Registration Information

How to register your copy of Zip Manager

Registration



Creating A New Zip File
Accelerator Key Ctrl + N

1.) Select File from the main menu by either Clicking on it with your mouse, pressing Alt F then the letter 
N or pressing the CTRL+ N key.

2.) The create a new Zip File Dialog Box will be displayed. The cursor will be resting on an Input field with 
a caption that reads, Enter Name/ Mask or select from List. The File Spec mask reads *.zip.

3.) Press the backspace key to clear the field and Enter the name of the new Zip File you wish to create. 
Then press Enter or Click on the OK button.

4.) A new Dialog Box will be displayed. The caption reads "Select Files For the new Zip"

5.) You will see that the cursor is flashing in the File Mask field. You have the option of leaving the mask 
set to *.* to display all files in a directory or you may change it to display only certain files such as *.bat to 
see all the batch files only. You can also Enter a full or partial filename. For instance to display all of the 
files with the name Doodle. You would Enter Doodle.* in the mask Box.

6.) The next option is the Use Wildcards Check Box. If you would like to add files to the Zip that only 
match a certain File Spec you should Click on this Box to check it. In this example we will use a Wildcard. 
Click on the Check Box now.

-> NOTE: When you are selecting files to Add to a Zip you do not have to use files that are in the same 
directory where are adding to or creating the Zip File. The only requirement is that you have to add files 
that reside in the same directory for each operation. In other words, if you want to add files from more 
than one directory to a Zip you must add them one directory at a time.

7.) Now we need to Enter a Wildcard File Spec. Lets assume that we only want to add the files that end 
with .DOC to our Zip. Press the tab key or Click on the W/C Mask field, and Enter *.doc To create the new
Zip press Enter.

-> NOTE: To add all the files in a directory to the Zip simply set the Wildcard Mask to *.* then press Enter 
or OK.

-> NOTE: In the select files Dialog Box there are Three fields labeled Size, Date, and Time. As you Click 
on a file in the Select Files List Box its size in bites, its date, and the time stamp. This is extremely useful 
if you are working with similarly named files. It will let you inspect each file so that only the correct ones 
are selected.



Extracting A Zip File
Accelerator Key Ctrl + Z

1.) Select Edit from the main menu by either Clicking on it with your mouse, pressing Alt E then the letter 
E. You will notice that the extract menu item has an arrow pointing to the right. Click on Extract or press 
Enter. A cascading menu will appear allowing you to select the type of file you wish to extract. Select Zip 
Files from the menu.

2.) The Extract a Zip File Dialog Box will be displayed. Select the Zip file you wish to extract. If the file is 
located on a different drive or directory select it by Clicking on the drive's/directories until the correct file is
found. Now press Enter or Click on OK.

3.) You are now presented with the option of extracting all of the files in the Zip, Selected Files in the Zip, 
and whether or not you would like to extract the files to a specific subdirectory. In this example lets    
extract selected files to a subdirectory. Click on selected files, and on Extract to a Subdirectory. Now 
press Enter or Click on OK.

4.) You will see a message on the screen that informs you that Zip Manager is reading the Zip File. In a 
few seconds a Dialog box will be displayed showing you all of the available files in the Zip.

5.) -> Please note that this Dialog Box has an extra button that reads "Display Mask". This functions with 
the File Spec you have Entered in the File Mask Box. If you changed the File Spec from *.* (the default) to
*.bat, you would then Click on the Display Mask button to display only those files with the extension of 
*.bat

-> If you change the File Spec, press the Tab key or Click on the Display Mask button. Pressing Enter or 
OK will cause an error message Box to appear notifying you that at least one file must be selected for this
operation.

6.) Now select files from the List. When finished press Enter or Click on OK.

7.) -> A Dialog Box will now prompt you for the directory into which you would like to extract the files. At 
this point you can Enter the complete drive and path destination in the scrollable edit field, or simply use 
the mouse to select the drive and directory from the List Box. When ready press Enter, or Click on OK to 
extract complete the extraction process.



Extracting ARC Files
Accelerator Key Ctrl + R

The steps to extract a file with ARC-E are identical to those for extracting a Zip File with the following 
exception.

-> You are able to extract entire ARC files only. You do have the option of extracting them to a selected 
directory however. 



Extracting LZH Files
Accelerator Key Ctrl + H

The steps to extract a file with LHARC are identical to those for extracting a Zip File with the following 
exception.

-> You are able to extract entire LZH files only. You do have the option of extracting them to a selected 
directory however.



Adding Files To A Zip
Accelerator Key Ctrl + A

1.) Select Edit from the main menu. Then select Add from the pull down menu. You can also use the 
Accelerator key combination Ctrl + A.

2.) The Open A Zip File Dialog Box will be displayed. You may Enter a Zip File name in the edit field, or 
select one from the List Box. If you choose to Enter the file name manually you can also Enter the 
complete drive and path parameters to the Zip File. Once you have made your selection press Enter or 
Click on OK.

3.) The Select Files To Add Dialog Box will now be displayed.

5.) You will see that the cursor is flashing in the File Mask field. You have the option of leaving the mask 
set to *.* to display all files in a directory or you may change it to display only certain files such as *.bat to 
see all the batch files only. You can also Enter a full or partial filename. For instance to display all of the 
files with the name myltr, you would Enter myltr.* in the mask Box.

6.) The next option is the Use Wildcards Check Box. If you would like to add files to the Zip that only 
match a certain File Spec you should Click on this Box to check it. In this example we will use a Wildcard. 
Click on the Check Box now.

7.) Now we need to Enter a Wildcard File Spec. Lets assume that we only want to add the files that end 
with .C to our Zip. Press the tab key or Click on the W/C Mask field, and Enter *.C

 -> NOTE: When you are selecting files to Add to a Zip you do not have to use files that are in the same 
directory where are adding creating the Zip File. The only requirement is that you have to add files that 
reside in the same directory for each operation. In other words, if you want to add files from more than 
one directory to a Zip you must add them one directory at a time.

-> NOTE: To add all the files in a directory to the Zip simply set the Wildcard Mask to *.* then press Enter 
or OK.

8.) When you have finished selecting files press Enter, or Click on OK.



Moving Files Into A Zip
Accelerator Key Ctrl + M
 
1.) To Move files into an existing Zip choose Move from the Edit Menu.

2.) Follow the same procedures as described above in adding files to a zip since the only difference in 
these procedures is the way the files are handled as outlined at the beginning of this section.



Deleting Files
Selected or an Entire Zip
Accelerator Key Ctrl + D

1.) Select Edit from the Main Menu, then choose Delete.

2.) The Delete A Zip File Dialog Box will be displayed. You may Enter a Zip File name in the edit field, or 
select one from the List Box. If you choose to Enter the file name manually you can also Enter the 
complete drive and path parameters to the Zip File. Once you have made you selection press Enter or 
Click on OK.

3.) You will now see a Dialog Box asking whether to delete the entire Zip file, or selected files within the 
Zip File. The delete an entire file is self explanatory. To delete selected files from a zip, Click on the 
selected files radio button and press Enter or Click on OK.

4.) The select files to delete Dialog Box will be displayed.

5.) -> Please note that this Dialog Box has an extra button that reads "Display Mask". This functions with 
the File Spec you have Entered in the File Mask Box. If you changed the File Spec from *.* (the default) to
*.bat, you would then Click on the Display Mask button to display only those files with the extension of 
*.bat

-> If you change the File Spec, either press the tab key or Click on the display mask button. Pressing 
Enter or OK will cause an error message Box to appear notifying you that one file must be selected for 
this operation.

6.) Select files from the List. When finished press Enter or Click on OK. The files you selected will be 
deleted from the Zip.



Freshen A Zip
Accelerator Ctrl + F

1.) Select Edit from the main menu, and then select Freshen from the pull down menu.

2.) Select a Zip File to freshen from the Freshen/Backup Dialog Box.

3.) Freshen will compare the current files contained in the Zip File you selected with the files currently in 
the SAME directory as the Zip File. If it detects that the any of the files on disk have a more recent time 
and or date stamp it will automatically update the Zip File with the more recent file contained on the disk. 
If none of the files have changed you will get a message in the DOS Window from PKZIP saying "PKZIP 
nothing to do".



Updating A Zip File
Accelerator Key Ctrl + U

1.) Select Edit from the main menu, and then select Update from the pull down menu.

2.) Select a Zip File to update from the Update a Zip File Dialog Box.

3.) Updating a Zip is nearly the same as Adding files to a Zip. It is intended to act as a manual version of 
freshen. The object is to let you decide which files on disk that have changed since the Zip File was 
created that YOU want to update in the Zip. Freshen on the other hand automatically updates every file 
that has changed even if you may not want it to. To summarize Update is basically a manual way to add 
selected files to an existing zip where the same files exist in the Zip.



Not Backed Up Since
Accelerator Key Ctrl + B

1.) The not backed up since option adds to the Zip all files that are in the current directory that haven't 
been backed up by the data backup program you normally use. Most backup programs change the file 
attribute so that the next time you run the program it will allow you to backup only the files that have 
changed since your last backup.

The PKZIP switch used for this option is -i It looks for files that have not been backed up.

2.) To use this option select the Not Backed Up Since option from the Edit menu.

3.) Select the Zip File you want to use from the List Box, or Enter the name of the Zip File you want to use
in the edit field Box.

4.) Zip Manager will now Add every file that has not been previously backed up in the Zip File you 
selected.



Testing A Zip File
Accelerator Key Ctrl + T

1.) To test a Zip File for integrity select the Edit from the main menu and then select Test from the pull 
down menu.

2.) Select the Zip File you want to test from the List Box, or Enter the name of the Zip File you want to test
in the edit field Box. Press Enter or Click on Ok. The results of the test will be displayed in the Window.

3.) If a Zip File is found to have some form of error you should use PKZIPFIX to attempt to repair it. You 
should then UNZIP it and create a new zip file with the files that you just extracted.



Adding A Zip File Title Comment

1.) To add a title comment to the Zip File select Edit from the main menu. You will see the Comments 
selection on the pull down menu. In this example we will add a Zip File Title. Select Zip File title from the 
menu and press Enter or Click on OK.

2.) Select the Zip File you want to comment from the List Box, or Enter the name of the Zip File you want 
to comment in the edit field Box. Press Enter or Click on Ok. You will see the DOS Window open on 386 
Computers or the full screen Window on 286 Computers. Pkzip will run and ask you to Enter the comment
for this Zip File. Enter the comment you want to add and press Enter. You will be prompted to press a key 
to return to Zip Manager.



Add/Edit Zip File Comments

1.) To add/edit comments in an existing Zip File select Edit from the main menu. You will see the 
Comments selection on the pull down menu. In this example we will add/edit comments to each file in the 
Zip. Select Add/Edit Zip from the menu and press Enter or Click on OK.

2.) Select the Zip File you want to use from the List Box, or Enter the name of the Zip File in the edit field 
Box. Press Enter or Click on Ok. You will see the DOS Window open on 386 Computers or the full screen 
Window on 286 Computers. Pkzip will run and display the old comment. If there wasn't an old comment 
that line will be blank. You will be prompted to Enter the new comment for each file in the Zip. If you don't 
want to add a comment to a particular file simply press Enter for that file. This process will repeat until 
each file in the Zip has had a comment added to it, or the old comment has been updated.



Adding Comments to New Files
Accelerator Key Shift + N

1.) To add a comment to new files in a Zip select Edit from the main menu. You will see the Comments 
selection on the pull down menu. It is a cascading menu item. In this example we will use New Files. 
Select New Files from the menu and press Enter or Click on OK.

2.) Select the Zip File you want to use from the List Box, or Enter the name of the Zip File in the edit field 
Box. Press Enter or Click on Ok. You will see the DOS Window open on 386 Computers or the full screen 
Window on 286 Computers. Pkzip will run and display only those files that DO NOT PRESENTLY have a 
comment. Enter a comment for each new file when prompted by PKZIP.



User Selected Comments
Accelerator Key Shift + U

1.) To add a comment to user selected files in a Zip select Edit from the main menu. You will see the 
Comments selection on the pull down menu. In this example we will use User Selected. Choose User 
Selected from the menu and press Enter or Click on OK.

2.) Select the Zip File you want to use from the List Box, or Enter the name of the Zip File in the edit field 
Box. Press Enter or Click on Ok. You will now be presented with a List of files contained in the Zip. Click 
on the ones you wish to add comments to and then press Enter or Click on OK. PKZIP will now start and 
allow you to add the comments to the files that were selected.



To View a Zip File follow these steps.
Accelerator keys:
Short Listing Ctrl + S
Long Listing    Ctrl + L

1.) Select View from the main menu.

2.) Select the file you wish to view from the Dialog Box. Press Enter or Click on OK. The file will be Listed 
in the Zip Manager Client area. You can use the Up, Dn, Left, Right, arrow keys to scroll around the 
Window to view the Zip. You can also use the PgUp and PgDn keys as well as the mouse to view the file 
area.



Clearing The Currently Displayed File.
Accelerator Key Shift + C

After you have finished viewing a Zip File, you can clear that Listing from the Window by selecting Clear 
List Window from the View Menu, or press Shift    the C key.



Password Protection Of your Zip Files

To add password protection select the Switches Menu and then Click on Password Encrypt. Now when 
you choose any of the Zip Manager file operations you will first be presented with a Dialog Box in which 
you Enter the Password. This password will then be stored as part of the Zip File. This option works when
adding individual files to a Zip, or when creating new Zip Files.



Storing Path Information
The -P Option

When you check the -P Store Path Info Option, Zip Manager will store along with each file you add to the 
Zip, the full path name where that file was located.



Recursing Directories With Zip Manager
The -rp Option

USING -rp STEP BY STEP

1.) Select the switches menu and Click on the -rp Recurse Directories/Path          option to select it.

2.) Select New or Edit from the main menu. Use the Drive/Directory List Box to select the directory where 
you want to create or add to a Zip File.

3.) Enter the Name of the Zip File you want to create if you making a new Zip, or select a Zip File from the
List of available Files.

4.) The select files to add Dialog Box will now be displayed. Ignore the File Mask edit field as it has no 
effect when you are using recurse. DO NOT SELECT ANY INDIVIDUAL FILES TO ADD TO THE ZIP. This
will prevent the recurse option from working.

5.) Activate the Use Wildcards Check Box by Clicking on it.

6.) Now Enter the Wildcard information. Zip Manager already knows the full path information.    Enter *.* 
as the Wildcard File Spec to use. THIS IS THE ONLY WAY THE RECURSE OPTION WILL WORK!

7.) Now press Enter Or Click On OK. This will start PKZIP and you can observe the progression as it first 
adds every file in the current directory to the Zip, and then proceeds to Add files from every directory that 
resides under the current one.



Retain the Original Zip Date
The -k Option

By setting the -k Retain original Zip File date option it will force PKZIP to keep the Zip Files Original date. 
In other words if the Zip had a date of 01-10-80 and you added files to it on 12-10-90. The Zip File would 
retain the 01-10-80 date.



Create Directories On Extraction
The -d PKUNZIP Switch

If you have a Zip File which was created with either the -P option or the -rp recurse option you can set the
-d switch on to inform PKUNZIP to restore the files to the directory name stored with each file in the Zip. 
This is a handy way to restore a file, or an entire directory that may have become corrupt.



Edit/Print
Accelerator Key Ctrl + E

This option calls the text editor or Word Processor you specified in the Zip Manager Setup. When you 
select this option Zip Manager will present a List of every file contained in the directory you select. Simply 
pick
the file you wish to load into your text editor. You can only edit one file at a time. When you have selected 
a file to edit, press Enter or Click on OK. The editor will start and the file will be loaded, ready to work on.



Using The LIST.Com Program
Accelerator Key Ctrl + F2

Zip Manager supports LIST.Com written by Vernon D. Buerg. This is an extremely useful program for 
quickly looking at files contained in a Zip File. If you use LIST with Zip Manager please register your copy 
with its author. Complete information on where to contact the author of each program is contained in 
Appendix B. Zip Manager uses LIST to allow you to view a file in a Zip without having to extract the entire 
Zip File first.

To use LIST follow these steps:

1.) Choose Run LIST.Com from the options menu or press Ctrl + F2

2.) The select a Zip File to LIST Dialog Box will now be displayed. Choose A Zip File and press Enter or 
Click on OK.

3.) A Dialog Box displaying the files contained in the Zip will be Displayed. Choose the file that you want 
LIST to load and press Enter or Click on OK. Zip Manager will attempt to extract the Zip File to the \
Windows\Temp\ directory. If you have the set temp = to a different drive/directory Zip Manager will use 
that directory to temporarily extract the file from the Zip. LIST will start and the file you selected will be 
displayed. NOTE: LIST Will NOT run in a DOS Window    even on 80386 computers.

4.) When you have finished using LIST, Zip Manager will delete the temporary file from the disk.



Using Scan With Zip Manager
Accelerator Key Ctrl + F3

Zip Manager fully supports the Virus Detection program Scan, published by McAfee Associates. You will 
notice that there will always be a number following scan. This indicates the number of known virus's that 
the current version knows about. If you use Scan with Zip Manager please register your copy with its 
author. Complete information on where to contact the author of each program is contained in Appendix B.

To use Scan follow these steps:

1.) Choose Scan For Virus from the options menu or press Ctrl + F2

2.) You will be presented with a Dialog Box displaying all of the files in the current directory. Choose the 
EXE of COM file you wish to Scan from the List Box and press Enter or Click on OK.

3.) A DOS Window will open up on 386 Computers, and A full screen Window will be displayed on 286 
Computers. You will be able to watch as Scan tests the selected file. After you have viewed the results 
you can press any key to close the Window and return to Zip Manager.



Making Self-Extracting EXE Files
Accelerator Key Ctrl    + F4

This option uses the Zip2Exe.exe program that comes with PKZIP.

To create a Self Extracting EXE follow these steps:

1.) Choose Make Self Extracting Zip from the options menu or press Ctrl + F4

2.) You will be presented with a Dialog Box displaying available Zip Files. Choose the Zip File you wish to 
convert and press Enter or Click on OK.

3.) A DOS Window will open up on 386 Computers, and a full screen Window will be displayed on 286 
Computers. You will be able to watch as the zip file is converted to an EXE file with the same name. The 
original zip file is left intact on the disk. You now have a Self Extracting executable.



Repairing Damaged Zip Files
Accelerator Key Ctrl + F5

An entire Zip File may become damaged, or files within the Zip may become damaged from time to time.   
Zip Manager supports PKZIPFIX so that you can attempt to repair these files. This option uses the 
PKZIPFIX.Exe program that comes with PKZIP.
To repair a Zip File follow these steps:

1.) Choose Repair Zip File from the options menu or press Ctrl + F5

2.) You will be presented with a Dialog Box displaying available Zip Files. Choose the Zip File you wish to 
repair and press Enter or Click on OK.

3.) A DOS Window will open up on 386 Computers, and a full screen Window will be displayed on 286 
Computers. You will be able to watch as the zip file repair is attempted. The repaired Zip File is renamed 
to PKFIXED.ZIP. The original zip file is left intact on the disk. You should now try to extract the 
PKFIXED.ZIP file and then create a new Zip with the files that were successfully extracted.



Control Key Quick Reference

Ctrl + A.. Add new files to a Zip
Ctrl + B.. Backup Files (-i) switch
Ctrl + D.. Delete a Zip or files in the Zip
Ctrl + E.. Start you editor and load a file
Ctrl + F.. Freshen a Zip file
Ctrl + H.. Extract an LZH file
Ctrl + L.. View a Zip, Long Zip listing
Ctrl + M.. Move files into a Zip
Ctrl + N.. Create a New Zip file
Ctrl + R.. Extract an ARC file
Ctrl + S.. View a Zip, Short Listing
Ctrl + T.. Test a Zip
Ctrl + U.. Update a Zip
Ctrl + X.. Exit Zip Manager(Quit)
Ctrl + Z.. Extract a Zip file
Ctrl + F2..Run LIST.COM
Ctrl + F3..Run Virus Scan
Ctrl + F4. Run ZIP2EXE Convert Zip To Self Extract
Ctrl + F5. Run PKZIPFIX Repair a Zip file



Shift Key Quick Reference

Shift + A.. Add comments to an entire Zip
Shift + C.. Clear A Zip Listing from ZM Client Area
Shift + N.. Add comments to NEW files IN a Zip
Shift + T.. Add a Zip Title comment
Shift + U.. User selected files to comment in a Zip
Shift + F1..Help



Trouble Shooting and Technical Support

If you are having trouble getting Zip Manager to function properly double check the following items:

1.) Check your setup to make sure each program setting contains the complete path and file name, 
including the program extension ie. EXE or COM. After you run the initial setup the values are written to 
your win.ini file. If you wish you can check the drive and path parameters there. All of the information is 
under the [Zip Manager] heading.

2.) Make sure that all of the program files described under the installation section are present.

3.) Check the ZMSCAN.PIF for the these settings:
All of the default settings are OK, except the following:

1.)    Program Filename:              ZMSCAN.EXE
2.)    Window Title:                      Zip Manager
3.)    Optional Parameters:        Blank
4.)    Start-Up Directory:          Blank
5.)    Memory Requirements:        KB Req 128    KB Desired: 640
6.)    Display Usage:                    Check the Windowed Radio Button
7.)    Execution:                            Check Exclusive
8.)    Close Window On Exit:      Make sure this box is checked
9.)    386 Users Click on the advanced button.
10.)    Detect Idle Time:            Check it OFF(Not Checked)
11.)    Emulate Text Mode:          Checked(ON)
12.)    Retain Video Memory:      Check it OFF(Not Checked)

4.) Make sure the directory in which you installed Zip Manager is in the path statement of your 
autoexec.bat file.

5.) Make sure that the directory where you store PKZIP, PKUNZIP, LIST, ARC-E and SCAN are also listed
in your path statement.

6.) Make sure that the program manager item for Zip Manager is set correctly.

7.) If you are still unable to get Zip Manager to function properly you can call us for technical support. We 
will provide support to un-registered users, as long as you are calling with the intent of registering your 
program if it functions properly. We want you to have a program you can be proud to own, and quality 
technical support is an important part of ownership.

IF ZIP MANAGER GIVES YOU A STRANGE ERROR MESSAGE CHECK THE ZMSCAN.PIF TO MAKE 
SURE THAT ONLY THE, FOREGROUND BOX IS CHECKED. Windows sometimes checks both of these 
boxes by itself!



Technical Support

We will provide technical support to un-registered users on their first phone call only if you are calling with
the intention of registering your copy of the program once your questions have been answered.

Please call us at 602-375-9502 Monday - Friday from 8:00 am - 4:00 pm Mountain Standard Time. 
Arizona does not go on daylight savings time. (Who wants it to stay light later when its 110 degrees 
outside!)

You can also call our BBS at 602-375-0531 1200 or 2400 baud, N81 and leave us a message in the Moon
Valley Shareware Forum. There is lots of other good shareware on the BBS so feel free to browse around
while your on-line.



Registration Information

To register you copy of Zip Manager Please use the file called REGISTER.FRM that is supplied with the 
program.

If you wish you can phone in your order using your Visa or Master Card Monday - Friday 8:00 am - 4:00 
pm MST. The order phone number is 602-375-9502
The registration fee is $21.50

Any correspondence should be addressed to:
Moon Valley Software Inc.
107 E. Paradise Lane
Phoenix, AZ USA 85022


